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What is Windows XP? 

Windows XP is a computer operating system and graphical user interface (GUI), which 
enables you to work with a wide variety of programs on your computer, often simultaneously. 
Windows XP is itself a special computer program that communicates your instructions to the 
actual computer hardware, and displays the results.  
Some of the key features of Windows XP are: 

Windows within Windows 
A Window refers to a rectangular area of the screen, within which you may view program 
folders and files, or display file contents such as documents, spreadsheets, and graphic 
images. A window can occupy part of the screen, can be maximised to fill the entire screen, 
or can be minimised so that it is no longer visible but remains active and is easily re-
accessed. 

The Desktop 
The Desktop gives you access to everything you need in Windows XP. It occupies the entire 
screen, and unlike a window, it can’t be reduced in size. The desktop consists of a coloured 
or patterned background, containing small pictures called Icons that represent programs or 
data stores. Double-clicking on an icon opens the corresponding program or file inside a 
window. 
 

 
 
The icons that are visible on your desktop depend on choices made at installation. In the UCT 
labs, you will usually see icons for  
y My Computer (the gateway to your computer’s drives, or data storage areas) 
y Recycle Bin (a temporary “trashcan” that holds files you want to delete) 
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The Taskbar 
The Taskbar lies across the bottom edge of your screen. The Start button on the left provides 
access to all the programs, data files, and other features available on your computer.  When 
you open a program or file, a corresponding rectangular icon will be displayed on your taskbar 
- even if the program has been minimised and is no longer visible on your screen. To access 
that program, you just need to click its icon on the taskbar! 

 
In this example, two windows are open; the Control Panel window (which is slightly darker in 
colour) is currently active. 

The Start menu   
When you click on the Start button, a set of menu options is displayed. The contents will vary 
depending on your computer setup and most frequently accessed programs. If you click on 
the All Programs option, you’ll see a list of all the programs installed on your computer – 
even those that don’t have icons on the desktop.  
Press the [ESC] (escape) key to close the menu.  

 

If you need help   
One of the menu options displayed when you click the Start button, is labelled Help and 
Support. If you select this option, a Help window will open. To get help on a specific topic, 
type a word or phrase in the blank space at the top left of the window and then click the 
search arrow; alternatively, you can click to browse any of the Help topics listed in the 
window. Click the X in the top right corner to close the Help window. 
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 Using your mouse 

The mouse is your most useful tool when working with Windows! It allows you to quickly 
select and run programs by simply clicking a button.  

It all clicks into place 
You can use your mouse in a number of different ways in Windows: 
1. Pointing Move your mouse so that the cursor points to an item on the screen.
2. Clicking Hold the mouse still, and click the left mouse button once. Clicking 

usually selects an object (highlighting it) or opens a menu or 
window. 

3. Double-clicking Hold the mouse still and click the left mouse button twice in quick 
succession. Double-clicking is usually used to open a program or 
file, or to expand a folder so that you can see its contents. 

4. Right-clicking Hold the mouse still, and click the right mouse button once. Right-
clicking usually opens a context-sensitive menu that provides you 
with a set of relevant options. 

5. Dragging Position your mouse on an object, hold down the left mouse button, 
and drag the object before releasing the button. 

Choosing or selecting? 
Selecting an item on your desktop means that you click on it once with the left mouse button, 
to highlight the object. 
Choosing an item means that you double-click it with the left mouse button, so that it is not 
only selected but also opened. You can achieve the same result by selecting the item and 
then pressing [ENTER] on the keyboard. 

Practice exercise 

With the Desktop visible: 
1. Point to an item and click on it once. Notice how it becomes highlighted. 
2. Drag one of your icons to a different point on the screen. 
3. Point the mouse to a blank area of the desktop. Right-click to open a pop-up menu, 

and use your mouse to select the option for arranging icons by name. 

 
 

4. Right-click on the My Computer icon to view its pop-up menu. Click an empty area on 
the screen or else press [ESC] on the keyboard to close the menu. 

5. Double-click on the My Computer icon to open its window. Then click the X in the top 
right corner to close it again. 
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Logging in and out 

All the computers in the UCT labs are linked to a network. You must log in before you use a 
computer – this process identifies you as a legitimate user. After you’ve logged in, you’ll be 
able to access your files even if you created them using a different computer.  

To log in 
The login window should be visible on the screen. If the screensaver is currently active, then 
just move the mouse slightly to return the login window to view. 

1. Type your login name (usually your student number) in the Username field of the 
dialog box. 

2. Type your password on the Password field of the dialogue box. 
3. Click on the OK button or else press [ENTER]. 

 
4. The Windows XP desktop will appear. In some labs you may then have to click 

another button to show that you accept the lab rules (such as no food or drink, and no 
cell phones). 

To log out 
After you’ve finished working, you must log out so that the next user of that computer won’t be 
able to access your personal files and email, or use your print credits. 

1. Click on the Start button on the taskbar. You will see an option to Log Off, as well as 
an option to shut down (i.e. turn off) the computer.  

 
2. Click on the Log Off button. The system will ask you to confirm that you are logging 

off. The network login box will then appear for the next user to log in. (Note: Don’t use 
the Shut Down option, or the next user will have to wait for the computer to start up 
again, which can take some time.) 

Practice exercise 

1. Log in to the network using your own user name and password. 
2. Log out correctly. 
3. Now log in again – well done! 
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Working with windows 

Let’s start by identifying the various components of a typical window, and how they are used.  

 

Title bar 
The top line of the window is called the Title bar, and displays the name of the corresponding 
program or folder. You can move an open window to a different part of the screen by dragging 
its title bar. If more than one window is open on the screen, then clicking on the title bar (or 
inside the window) will make a window active - which is indicated by a darkened title bar. 
There are three control buttons at the right end of the title bar, which are activated by clicking 
on them: 
y Minimise (on the left) keeps your program open, but reduces it to a rectangular 

icon on the taskbar.  
y Restore / maximise (in the middle) reduces the size of a full-screen window, or 

maximises a window that is not full-screen.  
y Close (on the right) closes the window or program.  

Menu bar and viewing options 
One row below the title bar is the Menu bar. If you click a word on the menu bar, a menu of 
additional choices appears. An arrow to the right of a menu option indicates that it has a 
submenu. 
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Some menu options can also be activated though a keyboard shortcut, such as [CTRL] + [C] 
for Copy. In this case the shortcut will be shown on the right of the menu option. 

 
If you accidentally open a menu and wish to close it, simply click on the title bar; or on a blank 
space within the window; or press [ESC] on the keyboard. 

Navigating inside a window 
If you can’t see all the information contained in a window, then use the Scrollbar at the bottom 
or right edge to view more. You can “move” the contents displayed in the window using the 
arrows at each end of a scroll bar: for example, clicking on the bottom arrow on the vertical 
scroll bar will reveal what lies below the bottom border of the window. Alternatively, you can 
drag the Scrollbox within the scrollbar to see hidden areas of the window.  
If a window is too big or too small for displaying the items it contains, then you can resize it. 
Hold your cursor over a border until it becomes a double arrow. Then drag the border to the 
size you want. 

Practice exercise 

1. Open the My Computer window by double-clicking on its icon. 
2. Move the My Computer window to a new position on the screen by dragging its title 

bar. 
3. Click on the View menu to see the available options. 
4. Change your View option to Details. Then change it back to Icons. 
5. Practice maximising, restoring and closing your My Computer window. 

 



Introduction to MS Windows XP  9 

 

 2009 Centre for Educational Technology, University of Cape Town 

 

Starting and exiting applications 

An application is a program that you use to do work with your computer – common examples 
are a spreadsheet, a word processor, or a database. There are two different ways that you 
can start up a Windows application:  

Using icons 
If the application you want to use has an icon, either on the desktop or inside a window, then 
you just need to double-click the icon and the program will start. An example is the My 
Computer icon on your desktop, used for viewing the drives and folders on your computer. 

Using the Programs menu 
Most of the applications on your computer probably won’t have desktop icons associated with 
them – the desktop would get too cluttered! So you need to be able to start applications using 
the Programs menu: 

1. Click on the Start button  
2. Point to the All Programs option on the Start menu. The Programs 

menu will appear. 
3. Click the name of the application that you want to use, and the corresponding 

program will open in a new window. 
Note that some applications (such as MS Office) consist of several related programs which 
may be grouped together in a submenu. If this is the case, then the application name on the 
Programs menu will be followed by an arrow. Move the mouse pointer over the arrow to see 
the submenu, then click on the required program. 

 
 

Practice exercise 

1. Click on the Start button. 
2. Select All Programs. 
3. Navigate your way to the Microsoft Word program. 
4. Open Microsoft Word. 
5. Close Microsoft Word. 



Introduction to MS Windows XP  10 

 

 2009 Centre for Educational Technology, University of Cape Town 

 

Working with multiple windows 

One of the most important features of Windows XP is its multitasking capability. This allows 
you to run more than one application at the same time. What’s more, within one application 
you could have several files open, each in its own window. For example, you might have both 
MSWord and MS Excel open at the same time, and within MS Word you might be working on 
two different document files, each in its own window. 

Moving between applications 
Each open window (even if it has been minimised) is represented by a rectangular icon on the 
taskbar at the bottom of your screen. The icon for the currently active window usually appears 
darker, and looks as if it has been “pressed in”.  

 
To switch between open applications, just click on the taskbar icon for the application that you 
want to switch to, and Windows will display its window on top of anything else that may be on 
your screen. 

Arranging windows 
When you have multiple windows open, some of them may be hidden by others. Windows XP 
helps you to arrange them so that all your open windows are visible. 
Cascade Open windows lie on top of each other, with the title bar of each one 

visible. To access a window that is not at the top of the cascade, just click 
its title bar. 

Tile horizontally Windows are resized so that they fit one above the other on the screen. 
Tile vertically Windows are resized so that they fit side by side on the screen. 
 

 
To change the way your windows are arranged, right-click on a blank area of the taskbar and 
choose the option that you want. 

 

Cutting and pasting between applications 
Windows allows you to cut or copy material from one application and paste it into another. For 
example, you can copy text from a page displayed in your web browser, and paste it into a 
Word document. Similarly, you could copy an Excel chart into a report you are writing in 
Word. 
You would do it like this: 

1. Open the application window from which you want to copy material, and select the 
text or data to be copied. 
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2. Choose the Copy command from the toolbar, the menu bar, or a 
pop-up menu.  

3. Open the application window into which you want to copy the 
selected text or data. 

4. Position the cursor where the copy should be inserted. 
5. Choose the Paste command from the toolbar, the menu bar, or a pop-up menu. 

(Some applications also have a Paste Special option which lets you specify in more 
detail how the material should be pasted. 

If the Copy and Paste commands aren’t available on a menu or toolbar, then you can use the 
following keyboard shortcuts: 
Copy : [CTRL] + [C] 
Cut : [CTRL] + [X] 
Paste : [CTRL] + [V] 
 

Practice exercise 

1. Open both the Control Panel and My Computer. 
2. Switch between the open windows. 
3. Display them in vertically tiled view. 
4. Close all the open windows. 
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Using Windows Explorer 

Windows Explorer is the file management tool that comes with Windows XP. It gives you the 
ability to rename, copy, move or delete the folders and files on your computer’s drives.  
Folders and files are displayed hierarchically within Windows Explorer. Folders can contain 
subfolders as well as files. 

Opening Windows Explorer 
To start Windows Explorer, find the My Computer icon on your desktop or the Start menu.  
Right-click to display the pop-up menu, and choose Explore.  

 
 
The window that opens will look similar to the example below. The title bar at the top of the 
window shows “My Computer”. All the drives and other storage devices associated with this 
computer are shown on in the right hand pane.  
 

 
 

Note that when you are working on the UCT network, you must NOT store your files on the C: 
drive. One of the network drives (usually the F: drive) will be identified by your student 
number, and has been allocated for your personal use. Because it is a network drive, it is 
accessible to you from any PC on the network. 

 
To navigate through the directory structure and locate files that you want to open, copy, move 
or delete, you would do as follows: 

1. Double-click on the required drive or removable device (floppy disk or flash drive) to 
display its contents. 

2. Within the selected drive or device, double-click on any folder to view the subfolders 
and files that it contains. 
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The title bar at the top of the window will then display the name of the currently selected 
folder. On the left side of the window is a list of all the drives and folders on your computer.  
y On the right side of the window is a list of all the folders and files located inside the drive 

or folder that is currently selected in the left pane. 
In the left pane: 
y A plus sign “+” next to a folder indicates that it contains subfolders that are not currently 

visible. Clicking on the plus sign (or double-clicking on the folder name) will reveal the 
subfolders. 

y A minus sign “-“ next to a folder indicates that all its subfolders are currently visible. Click 
on the minus sign (or double-click on the folder name) to collapse the subfolders and hide 
them from view. 

y Indentation levels in the left pane reflect the folder directory structure. 
You can drag the vertical line between the left and right panes to make them wider or 
narrower. 
If there are too many entries to be displayed in a pane, then you can use the vertical scroll bar 
to view the hidden entries. 
 

Selecting folders or files  
In the left pane, click on a drive or folder that you want to select. Its contents will be displayed 
in the right pane. Similarly, you would click on a file in the right pane to select it. 
To select a group of adjacent files or folders: 
y Click on the first file (or folder) in the group that you want to select. It will become 

highlighted. 
y Hold down the [SHIFT] key and click on the last file (or folder) in the group that you want 

to select. All the items between the first and the last file (or folder) selected will also be 
highlighted. 

y Release the [SHIFT] key. 
To select separate files and folders: 
y Click on the first file (or folder) that you want to select. It will become highlighted. 
y Hold down the [CTRL] key and click on each of the other files (or folders) that you want to 

select. All the items that have been selected will be highlighted. 
y Release the [CTRL] key. 
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Creating a new folder 
To create a new folder in Windows Explorer:  

1. In the left pane, highlight the folder within which you want to create a new folder. If 
you don’t want the new folder to be a sub-folder of an existing folder, then select the 
Drive (such as F:) that the new folder should be in. 

2. Select the File menu and hold the mouse pointer over the arrow on the right of the 
New command. Choose Folder from the sub-menu that appears. A highlighted folder 
icon called [New Folder] will appear at the bottom of the right pane. 

 
3. Type the name that you want to give the new folder, and press [ENTER]. Your new 

folder has been created! 

 
 

Saving a new file 
Whenever you start a new task using an application such as Word or Excel, you’ll need to 
save your work in a file. The process for saving a new file is basically the same for all 
Windows applications; the examples used here are based on Word. 

1.  At the top of the screen, click on the File menu, and then select the 
Save As option from the drop-down menu. (If your window shows a 
task bar with buttons, then you can click instead on the icon of a stiffy disk.) 
Note that in Office 2007, the File menu has been replaced by the Office Button.  
A dialogue box will open. 

2. In the Save In field, use the drop-down arrow to select the drive and folder where you 
want your file to be stored. 

 
3. In the File Name field, type the name that you want to give your new file. 

 
4. Click the Save button. It’s as easy as that!  
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Renaming folders or files 
1. Highlight the folder or file that you want to rename. 
2. Select the File menu and choose the Rename command. Alternatively, you can right-

click on the current file name to get a pop-up menu, and then select Rename. 
3. The current folder or file name is highlighted. Type the new name and press 

[ENTER]. 
Be careful when renaming files that you keep the appropriate file extension (such as “.docx” 
for an MS Word 2007 file). If you change or delete a file extension then you may not be able 
to re-open the file. If your file extensions are not visible then Windows will automatically retain 
them for you. 
 

Copying folders or files 
Within Windows Explorer, there are lots of different options for copying folders and files! 
Commonly used methods for doing this are: right-clicking, using a toolbar icon, using a menu, 
using the keyboard, and dragging with the mouse.  

Before you can copy, the file (or folder) that you want to copy must be selected. It’s also a bit 
easier if your target folder is visible in the left pane. So I recommend that you first click on the 
folder containing the file to be copied, and ensure that the file you want is visible in the right 
pane. Then scroll through the folders in the left pane until the target folder is visible. Now you 
can see the file you want to copy on the right, and its target folder on the left. 

 
y Right-clicking: 

1. In the right pane, select the folders or files you want to copy. 
2. Right-click to display the pop-up menu, and select Copy.  
3. Move the mouse pointer to the folder in the left pane that you want to 

copy to. 
4. Right-click and select Paste from the pop-up menu. 

 
y Toolbar icon: 

1. In the right pane, select the folders or files you want to copy. 
2. Click the Copy To icon on the toolbar.  
3. The Copy Items dialogue box will open. 
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4. Select the destination folder and click the Copy button. 
 
y Menu bar: 

1. In the right pane, select the folders or files you want to 
copy. 

2. Click Edit on the menu bar, and choose Copy from the list 
of options.  

3. Select the destination folder. Click Edit on the menu bar 
and then Paste. (Alternatively, you can choose Copy to 
Folder, which opens the dialogue box shown under the 
preceding Toolbar option.) 

 
y Keyboard: 

1. In the right pane, select the folders or files you want to copy. Press [CTRL] + [C] on 
your keyboard. 

2. Select the destination folder. Press [CTRL] + [V] on your keyboard. 
 

y Dragging: 
1. In the right pane, select the folders or files you want to copy. Click and hold down the 

left mouse button. 
2. If you are copying them to another location on a different drive, then drag them to the 

destination folder and release the mouse button. 
3. If you are copying them to another location on the same drive, then hold down the 

letter [C] on the keyboard while you drag them to the destination folder. You can then 
release the letter [C] and the mouse button. 
Ensure that you drop the copied files exactly on the destination folder – this will be 
highlighted as you drag over it. If you “lose” your files, it’s a good idea to check in the 
folders above and below the destination folder, to see if the copied files landed there.  

Remember that you can use the Undo function to undo a command you have just 
executed, including copying files.  

 

Moving folders or files 
Using Windows Explorer, you can move folders and files using similar methods to those 
shown above for copying: 
y Right-click, and select Cut (instead of Copy) followed by Paste. 
y Use the Cut and Paste icons on the toolbar. 
y Use the Cut and Paste options on the Edit menu. 
y Use [CTRL]+[X] followed by [CTRL]+[V] on your keyboard 
y Drag your files to the new location. If the new location is on a different drive then hold 

down the [SHIFT] key while dragging, otherwise Windows will make a copy, and you will 
still need to delete the original file. 

Again, your task will be easier if you first make the destination folder visible in the left pane 
before you select the files that you want to move from the right pane. 

So what is the difference between copying and moving a file? When you copy a file, the 
original file remains in the source folder, so you end up with two copies of the file, one in the 
source folder and another in the destination folder. When you move a file, the original 
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disappears from the source folder, and you are left with only one copy of the file, in the 
destination folder. 

 

Deleting folders or files 
Deleting files and folders is dangerously easy! Here again, you have several options: 
y Select the file or folder, and click the Delete icon on your toolbar.  
y Select the file or folder, and click the [DEL] key on your keyboard. 
y Click File on the menu bar and select Delete. 
y Right-click the file or folder and select Delete from the pop-up menu. 
y Select the file or folder and drag it to the Recycle bin on your desktop. 
When you delete a file or folder, Windows will ask you to confirm the deletion. Make sure that 
you have the right file before clicking Yes. 

1 Warning: It’s not always possible to recover files that you have deleted, especially if they 
were deleted from a network drive. Be very careful not to delete files that you may need again 
in the future! Remember that when you delete a folder, you also delete any files in that folder. 

 

Practice exercise 

1. Open Windows Explorer and identify your F: drive. 
2. Create the folder F:\Test 
3. Create the sub-folder F:\Test\Sub 
4. Delete the folder and the sub-folder that you have just created. 
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MS Windows Task Sheet 1 

Introduction to PCs 
Answer the questions below, making your explanations as clear as possible. 

 
 
1.  What is the difference between Hardware and Software? 

 

 

 

 

2.  Name two input devices and two output devices.  

 Input: 

 Output: 

3.  Why do you need to log in to the computers in the UCT labs? 

 

 

 

 
4.  Your computer has a C: drive and an F: drive. Which of these should you use to save 

your files, and why? 
 

 

 

 
5.  What is a computer virus, and what precautions can you take to avoid infecting your 

computer? 
 

 

 

 

6.  When would you log off from a computer, and when would you use shut down?  
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MS Windows Task Sheet 2 

File management 
Log in to a PC in the lab, and complete the following exercises. 

 
 
Step Instruction Notes 

1. Start Windows Explorer. See page 12 

2. Open your F: drive.  

3. Create a new folder on your F: drive, called File Management. See page 14 

4. Create a second new folder on your F: drive called Exercise.  

5. Now create a subfolder within the File Management folder, 
called Task Sheet. 

 

6. Minimise the Windows Explorer window. See page 7 

7. Use Start – All Programs – Accessories to open the Notepad 
program. 

See page 9 

8. Type your name inside the Notepad window.  

9. Save the Notepad file in the Task Sheet subfolder on your F: 
drive, with the name Identity. 

See page 14 

10. Close the Notepad window. See page 7 

11. Restore the Windows Explorer window.  

12. Copy the Identity file from the Task Sheet subfolder to the 
Exercise folder. 

See page 15 

13. Rename the Identity file in the Exercise folder, to call it Identity 
Copy. 

 

14. Delete the original Identity file in the Task Sheet subfolder. See page 17 

15. Delete both the Task Sheet subfolder and the File Management 
folder. 

 

16. Close Windows Explorer.  

17. Log out from your PC. Well done!  

 
 


